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1 Payroll and Post Payroll Processing

The payroll process runs at a specific point in time, not only to calculate an employee's basic remuneration but
also any special payments, overtime payments, or bonuses that must take effect in the period in question.

This scenario describes the typical steps to process payroll for employees in SAP SuccessFactors Employee
Central Payroll using data replicated from SAP SuccessFactors Employee Central. It consists of the steps
that prepare the payroll run, the payroll run itself, the creation of payment data, printing of employee pay
statements, and finally posting to financial accounting.

The end-users have two options to execute this scenario:

* Option 1: using the classical payroll-related transaction codes starting from the Employee Central Payroll
menu;

* Option 2: using the SAP Payroll Control Center, in case it has been integrated in Employee Central. In this
case, payroll and post-payroll processing can be executed in Employee Central, which calls the Employee
Central Payroll system via the Payroll Control Center screen, which is exposed through a gateway.

i Note

Within this document, Option 1 will be described in detail. For Option 2 we give only a high-level
description; note that there exists an SAP Best Practices for SAP Payroll Processing control center,
in which you can find a detailed description of executing payroll and post-payroll processing using the
SAP Payroll Control Center.

This document provides a detailed procedure for testing the scope item Payroll and Post Payroll Processing
after solution activation, reflecting the predefined scope of the solution. Each process step, report, or item is
covered in its own section, providing the system interactions (test steps) in a table view. Steps that are not in
scope of the process but are needed for testing are marked accordingly. Project-specific steps must be added.

Payroll and Post Payroll Processing: Test Script
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2 Prerequisites

This section summarizes all prerequisites to conducting the test in terms of systems, users, master data,
organizational data, and other test data and business conditions.

System Access and Roles

The test is conducted in the following systems:

System Details

SAP SuccessFactors Employee <Provide details on how to access system, for example system client or URL>
Central

SAP SuccessFactors Employee <Provide details on how to access system, for example system client or URL>

Central Payroll

i Note

In the following, we will use the following abbreviations for the systems:

* SAP SuccessFactors Employee Central will be referenced as Employee Central.

* SAP SuccessFactors Employee Central Payroll will be referenced as Employee Central Payroll.

Use the following standard test users or assign roles to testers, respectively:

Business
Role Business Role Description Business Role ID Log On
Payroll Ad- A person who performs in SAP SuccessFactors Employee Cen-  None delivered Test user:
ministrator tral Payroll all payroll tasks carried out at the employee level. <userid>
Password:
<password>
HR Admin- A person who performs in SAP SuccessFactors Employee Cen-  For testing purposes, Test user:
istrator tral all tasks that relate to the administration of employees. only: SAP BestPractices <userid>
Super Admin
Password:
<password>

Employee A person who contributes to the creation of goods or services SAP BestPractices Em-  Test user:
for a company. He or she is bound by instructions and obliged to  ployee (Self Service for <userid>

adhere to the company's policies and regulations. EC)
Password:

<password>

Master Data, Organizational Data, and Other Data

Payroll and Post Payroll Processing: Test Script
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The enterprise structure and master data of your company has been created in your SAP SuccessFactors
Employee Central instance. The enterprise structure reflects the structure of your company and includes the
company, cost center and location in the system. The master data represents the employees of your company
and has been replicated to SAP SuccessFactors Employee Central Payroll.

i Note

In case SAP SuccessFactors Employee Central is not yet in place, note that there exists a best practice
for SAP SuccessFactors Employee Central, which can be used as starting point for implementing SAP

SuccessFactors Employee Central.

Business Conditions

Before this scope item can be tested, the following business conditions must be met.

Business Condition

Comment

1 The employee's master data record has been repli-
cated successfully to SAP SuccessFactors Employee
Central Payroll. Payroll-relevant data has been main-
tained for the employee.

To obtain this, complete the appropriate steps described in test
script Update Payroll-Relevant Data.

If appropriate, short-term absence data for a partic-
ular payroll period have been maintained and repli-
cated successfully to SAP SuccessFactors Employee
Central Payroll.

To obtain this, complete the appropriate steps described in test
script Replicate Absence Data.

For employees of subgroup Hourly the worked hours
as maintained by them in a 3rd party time manage-
ment system have been passed to the SAP Success-
Factors Employee Central Payroll system, populating
infotype 2010 (Employee Remuneration Info).

This business condition is relevant if your company uses a 3rd
Party Time Management application integrated with SAP Suc-
cessFactors Employee Central Payroll.

A Caution

The integration to 3rd Party Time Management is not in
scope of this SAP best practices.

The employee, if eligible, has been enrolled in saving
plans. Appropriate data has been maintained in the
SAP SuccessFactors Employee Central Payroll sys-
tem.

To obtain this, complete the appropriate steps described in test
script Manage Third-Party Benefits.

- Recommendation

It is recommended to hire several employees, with different employee classes, employment types, pay
groups, and so on. Having this, you can consider different combinations of change in job and compensation
information, and time off. This ensures a payroll and post payroll processing that fulfills your company’s

needs as much as possible.
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2.1 Preliminary Steps

2.1.1 Maintain Cost Distribution (Optional)

Use

In the infotype Cost Distribution (0027), you can determine how costs for an employee are to be distributed to
different account assignment objects.

For employees to process through payroll successfully, they must be assigned to a cost center. Typically, the
employee inherits a cost center through his or her assighment in the organizational structure. However, if
an employee without an organizational assignment must be processed through payroll, a cost center can be
assigned to the employee using infotype 0027.

For example, if retirees are to be paid via payroll and they do not hold a position with the company they do not
inherit a cost center. In this case, to run the retirees' payroll you can assign the cost center using infotype 0027.

Prerequisites

Company codes have been replicated from Employee Central, and cost centers have been replicated from SAP
Fl/CO.

Procedure

1. Access the transaction in Employee Central Payroll using one of the following options:

Transaction Code Employee Central Payroll Menu Path

PA30 |\ Human Resources # Personal Management # Administration # HR Master
Data > Maintain ]

2. Onthe Maintain HR Master Data screen, make the following entries:

Field Name User Action and Values

Personnel no. <employee®s personnel number>

Payroll and Post Payroll Processing: Test Script
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Field Name User Action and Values

Infotype 0027

3. Choose the Enter key.
4. Choose the Create icon.
5. Onthe Create Cost Distribution (Infotype 0027) screen, make the following entries:

Field
Name Description User Action and Values
Start Start date of new record <start date>
To End date of new record <end date>
If there is no end date, leave as 12/31/9999.
Distrib. Costs to be distributed Enter 01, or select 01 Wage/salary from
dropdown
CoCd Company Code Enter USO1, or select USO1 from dropdown
Cost Ctr ~ Cost Center <cost center>
Pct. Weighting Percentage: This field contains a percentage 100

which is used to weight the assignment of object character-
istics for one or more objects.

< Example

A person's working time is divided equally between two
positions. In this field, you could enter a 50% assign-
ment of working time.

6. Choose the Enter key to check the entries.
7. Save your entries. The system accepts the data and completes the new record.
8. Repeat activities # 2 to #7 for other employees, as required, too.

Result

The employee's cost distribution record is created.

Payroll and Post Payroll Processing: Test Script
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2.1.2 Maintain Payroll Control Record

Purpose

A Caution

In a production system, the payroll control record should only be created for the payroll area for the first
pay period in which the payroll is run; this being the reason of describing it as preliminary step and not as
process step within the business process. Subsequently, the payroll control record should always advance
through the Payroll process.

The control record enables the system to determine for what period a particular payroll area is being
processed. Depending on the characteristics of the payroll area (such as the frequency and whether you are
processing payroll as current, in advance or in arrears), this may not translate directly to the existing system
data.

In addition, the control record keeps the information how far back SAP SuccessFactors Employee Central
Payroll can process prior periods.

The payroll control record has the following functions:

* Itlocks the personnel numbers for which payroll is processed against master data changes that affect the
payroll past or present.

It makes the following information available for the system:

* The current payroll period for which regular payroll should be processed
* Date to which retroactive accounting can be performed
* Payroll Status (for example, Released f. Payroll or Check Payroll Results)

When you release payroll, the system automatically forwards the pay period to the current pay period (for
example, from 01 2019 to 02 2019).

If you use Start payroll, Corrections or Exit payroll via the Employee Central Payroll Menu path, the system
automatically changes the payroll status in the payroll control record.

i Note
1

The payroll areas relevant within this document are the following:

* UM (HR-US: Monthly)

* US (HR-US: Semi-monthly)

* UW (HR-US: Weekly)

®* UX (HR-US: Bi-weekly)
For payroll area UN (HR-US: Non-Payroll), payroll will not be run, therefore it is not taken into
consideration.
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i Note

2

When describing the process steps procedures in chapter Test Procedures of this document, we consider
value UM (HR-US: Monthly) as concrete example for the payroll area. The procedures for the other
payroll areas are the same as for this concrete payroll area.

Procedure

1. Access the transaction in Employee Central Payroll using one of the following options:

Transaction Code Employee Central Payroll Menu Path
PAO3 |+ Human Resources ¥ Payroll » Americas » USA #» Tools » Control
Record 4

2. Onthe Payroll control record screen, make the following entry:

10

Field
Name Description User Action and Values

Payroll Payroll area for which the payroll control record should be select UM (meaning HR-US :Monthly)
area set.

Choose the Enter key.

To set the payroll control record to the appropriate payroll period for testing, the existing record must be
deleted and then recreated. On the Payroll control record screen, choose Delete.

Create the payroll control record for the selected payroll area, by choosing Create. For example, if you need
to process a monthly payroll for pay period 01 2019, you choose 01 2019.

On the Payroll control record screen, make the following entries:
Field Name User Action and Values
Payroll period <last payroll period>;forexample, if payroll period 03 is being processed, enter

payroll period 02

Earliest retro acctg enter as appropriate
period

Save your entries.

O\ Caution

In a production system, activities #3 to # 6 should be executed only once to set the payroll control
record for the first period being processed after go-live.
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7. To change the payroll area status, use one of the below options:
Option 1: Choose Change. Choose Released f. Payroll to change the status of the payroll control record

accordingly. The Pay period field shows the period for which payroll is to run. Save your entries to process
the appropriate pay period.

Option 2: In the Employee Central Payroll Menu navigate to |# Human Resources » Payroll » Americas

» USA » Payroll » Release payroll 3 and on the upcoming Release for payroll dialog box choose Yes.
8. Repeat activities # 2 to # 7 for all other relevant payroll areas (refer to Note 1 [page 9] above).

Result

The payroll control record has been created and released for the selected payroll area(s).
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3 Overview Table

The scope item Payroll and Post Payroll Processing consists of several process steps provided in the table

below.

Process Step

Business Role

Transaction

Expected Results

Execute Payroll Simulation Run Payroll Admin- PCOO_M10_CALC_ The payroll simulation run has been executed to
[page 17] istrator SIMU reveal possible errors in the payroll-relevant data
records of employees.
Release Payroll Area for Correction Payroll Admin- PCOO_M99_PAO3_ The payroll area has been released for correc-
(Optional) [page 21] istrator CORR tion.
Correct Payroll-Relevant Master HR Adminis- Company Instance Payroll-relevant master and/or time data has
Data and/or Time Data (Optional 2o URL been corrected.
External Process Step) [page 22]
;rig%erfmplgyetg Malster Dat§3 :'RtAdminiS' Company Instance The replication of the intentionally corrected
eplication (Optional) [page 23] rator URL master data has been triggered. As a result,
the employee's master data record is updated
in Employee Central Payroll.
Set Payroll Area [page 25] Payroll Admin- PCOO_M99_ABKR The relevant payroll area has been set for further
istrator S processing.
Release Payroll Area [page 26] Payroll Admin- PCOO_M99_PAQO3_ The relevant payroll area has been released for
istrator RELEA further processing.
Execute Payroll Run [page 27] Payroll Admin- PCOO_M10_CALC The productive payroll run has been executed.
istrator
Releas(e) P?yrolll Area fo;(())orrec— Payroll Admin- PCOO_M99_PAO3_ The payroll area has been released for correc-
tions (Optional) [page 30] istrator CORR tion.
Correct Payroll-Relevant Master HR Adminis- Company Instance Payroll-relevant master and/or time data has
Data and/or Time Data (Optional  trator URL been corrected
External Process Step) [page 31] '
'Fl;rig%er Emplgyeg Malster Dat;z HR Adminis- Company Instance The replication of the intentionally corrected
eplication (Optional) [page 32] trator URL master data has been triggered. As a result,
the employee's master data record is updated
in Employee Central Payroll.
(F;elease_ PaeroII A(;ea_for I|3ayroll Payroll Admin- PCOO_M99_PAO3_ The payroll area has been released for correc-
orrection Run (Optional) [page istrator RELEA tion run.

33]
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Process Step

Business Role

Transaction

Expected Results

Execute Payroll Correction Run

Payroll Admin- PCOO_M10_CALC The payroll correction run has been executed.
(Optional) [page 34] )
istrator
View Payroll Results [page 36] Payroll Admin- PC_PAYRESULT Payroll results have been displayed.
istrator
DeIeteSI;ayroII Results (Optional) Payroll Admin- PUOL The payroll results for an employee who should
[page 38] istrator not have been included in the payroll run have
been deleted.
EXGCUTOFI Posting Simulation Run  poy 611 Admin-  PCO0O_M99_CIPE  Simulation General Ledger posting documents
[page 40] istrator have been created.
:XeCLl'te_Thi;d‘Party R‘jgittance Payroll Admin-  PCOO_M99_URME  The simulation of third-party remittance tables
imulation Run [page 43] istrator to be updated within the organization has been
executed.
Create Test Payment Data Using Payroll Admin- PCOO_M10_CDTC A test run for payment data has been executed.
Preliminary Program Data Medium istrator
Exchange [page 46]
Exit Payroll [page 49] Payroll Admin- PCOO0_M99_PAO3_ The payroll control record shows status Exit Pay-
istrator END roll.
View R:gnuneration Statement HR Adminis- Company Instance Remuneration statements of one or more em-
[page 50] trator URL ployees have been viewed.
View n;é Remuneration Statement  Employee Company Instance The own remuneration statement has been
[page 52] URL viewed.
Create Payment Data Using Pre- Payroll Admin- PCOO_M10_CDTC Payment data has been created.
liminary Program Data Medium istrator
Exchange [page 54]
CreateSI;irect Deposit Test File Payroll Admin- PCOO_M99_FPAY  Before creating the direct deposit file to be sent
[page 58] istrator M to the bank, a test run of the file creation is exe-
cuted.
glreate Direct Deposit File [page Payroll Admin- PCOO_M99_FPAY  Direct deposit file to be sent to the bank has
] istrator M been created.
Execute FI Posting Run [page 65] Payroll Admin- PCOO_M99_CIPE A posting document, which is to be transferred
istrator to Fl, has been created.
Procsess F(') Posting ngn (Prcl)c- Payroll Admin- PCPO, not in scope All posting documents have been released and
ess Step Outside of Scope ltem istrator of this best practi-  posted.
Scope) [page 68] cos
Execute Thérd-Party Remittance  poy ol Admin-  PCOO_M99_URME  The document for third-party remittance has
un [page 69] istrator been created.
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Process Step Business Role Transaction Expected Results

Execute Third-Party Remittance

Payroll Admin- PCOO_M99_URMP Remittances in the form of a sequence of docu-
Posting Run [page 71]

istrator ments have been created and are ready to be
released to Fl.

Follow-Up Activities in Third-Party
Remittance Processing (Outside of
Scope Item Scope) [page 74]

Payroll Admin- not in scope of this  All third-parties to which tax, garnishment,

istrator best practices membership or benefits payments are owed
have been paid. The amounts have been posted
to the appropriate general ledger, subledger and
bank accounts in FI/CO.

Payroll and Post Payroll Processing: Test Script
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4 Test Procedures

This section describes test procedures for each process step that belongs to this scope item.

i Note

When describing the process steps procedures in this chapter, we consider value UM (HR-US: Monthly)
as concrete example for the payroll area. The procedures for the other payroll areas are the same as for this
concrete payroll area. Feel free to use during testing any other payroll area delivered within this SAP best
practices.

Employee personnel master data and time data, and possibly benefits data, is maintained for all employees
within the payroll period timeframe. The payroll process runs at a specific point in time, not only to calculate an
employee's basic remuneration but also any special payments, overtime payments, or bonuses that must be
effected for the period in question.

A high-level overview of the payroll process is below:

Run payroll in simulation mode to view any possible errors.
Release the control record for appropriate payroll area.

Execute the payroll run. The system accesses a country-specific payroll program. It determines the current
payroll period from the payroll control record and performs payroll using the values you entered in the
payroll program.

Check whether payroll has run correctly or determine where errors have occurred. If the payroll has errors,
the system displays error messages indicating where the errors have occurred. If desired, you can obtain

a detailed payroll log. However, we recommend that you only create a payroll log during simulation of the
payroll run.

If there are errors, put the payroll area into Correction mode. You correct master data or time data for
personnel numbers that contain errors and which the payroll program could not process. During the payroll
run, the system flags the Payroll correction checkbox in the Payroll Status infotype (0003) for all rejected
personnel numbers. When you correct master data or time data for a personnel number, this field is also
flagged if your control record is in status Released for Correction, since there has been a change to the
current data and payroll needs to be rerun for these individuals. These personnel numbers are grouped
together in a list under the search help W (also called Payroll correction run). In a payroll correction run (a
payroll run with search help matchcode W), payroll only takes place for the corrected personnel numbers.

Release payroll again. The payroll period does not change.

Perform a payroll correction run. If there are many employees stored in search help W (Payroll correction
run), you perform this step as a background job in the same way that you performed the payroll run step. If
you only have to run payroll again for a few employees, you can perform this step online.

Simulate the posting to Accounting.
The system tests your posting run for accuracy and balances and verifies the accounts. If everything is
correct, you are able to post to accounting in production mode.

Simulate Third-Party Remittance
Create the remuneration statements (pay statements).
Exit payroll.
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This step concludes the payroll process and allows you to run posting to accounting and third-party
remittance in production mode. All employees pay must have been verified and correct before you exit
payroll. This step is critical, since after you have run posting to accounting or bank transfer, you cannot go
back to the status Released for Payroll for the current pay period.

Post to Accounting in production mode.
This step allows you to create the relevant documents and post to general ledger.

Process Fl Posting Run.
This step allows you to transfer your posting run of the released documents to Finance.

A\ Caution

A prerequisite for executing this process step successfully is the integration between the Employee
Central Payroll system and the SAP Finance system. As this integration is not in scope of the present
SAP best practices, this process step is out of scope, too.

Third-Party Remittance

The Third-Party Remittance process involves the transfer of financial posting data from HR to FI/CO
accounts. The third-party remittance component generates actual physical payments in the form of bank
transfers or checks. However, third-party remittance differs from the FI/CO Transfer component in one
critical way - it exclusively handles posting and payment information for external payees, such as tax
authorities, garnishment recipients and benefits providers.

A\ Caution

Some basic configuration for executing third-party remittance is provided through the activation
content of this SAP best practices.

A successful execution of Third-Party Remittance requires the existence of payee data in the system, as
well as the integration to the Finance system. The present SAP Best Practices package does not deliver any
payees with this solution, neither is the integration setup to the Finance system in scope. Therefore, the
process steps to be executed within third-party remittance are listed only high-level below.
* Evaluate Third-Party Remittance in production mode
Third-party remittance/AP posting allows you to post payments to accounts payable for third-party
vendors. Taxes, benefits and garnishments are sent out to different vendors or authorities. During
payroll processing, various deductions are calculated. These deductions need to be remitted according
to a remittance rule. Third-party remittance allows you to schedule these payments accordingly.
* Process Third-Party Remittance Posting Run
This step takes the accumulations from the step before and posts the relevant data to accounts
payable.
* Reconcile Postings
This report produces a list of all third-party remittance items that have been evaluated, posted, or paid.
The list also contains information confirmed by Fl, such as receipt of the posting, acknowledgement/
payment of the posting and payee item details.

¢ Create Third-Party Remittance Payment
The execution of third-party remittance creates payables to vendors. In this step, the payables are
picked up and payments to the vendors are generated.

* Run Remittance Completeness Check
This program does the following:

* Employees and payroll results that have not been evaluated
* All payee items that have been evaluated but not posted to Fl

Payroll and Post Payroll Processing: Test Script
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¢ All posting runs in transaction PCPO (Display posting runs) that have not been released.

i Note

In case the Payroll Control Center is integrated in Employee Central, instead of accessing the
Employee Central Payroll Menu, the end-users can execute the payroll and post payroll processing
directly in the Employee Central system. This system calls the Employee Central Payroll system, via the
Payroll Control Center screen, which is exposed through a gateway.

When using the Payroll Control Center, three pre-configured processes are delivered, each of which
contains a certain number of sequential process steps to be executed:

* Team Monitoring: the process designed for creating test payroll results and running policies (these being
groups of validation rules), which are based on real payroll results. The alerts issued during this phase
can be assigned to specified administrators for resolution, or the administrators can assign them to
themselves from the list of alerts. By taking care of all alerts appearing during this phase, the perfect
payroll data will be achieved for the productive payroll run. Basically, process steps Execute Payroll
Simulation Run [page 17] to Release Payroll Area [page 26] within this document would be covered
by this preconfigured process.

* Production Payroll: the process designed for running the productive payroll, as well as the posting
simulation run. In case alerts are issued during this phase, they can be assigned to specified
administrators for resolution, or the administrators can assign them to themselves from the list of alerts.
The alerts need to be solved before conclude the payroll processing. Basically, process steps Execute
Payroll Run [page 27] to Exit Payroll [page 49] (except Execute Third-Party Remittance Simulation
Run) within this document would be covered by this preconfigured process.

* Posting to Finance: the process designed for executing the post payroll processing activities. Basically,
process steps Create Payment Data Using Preliminary Program Data Medium Exchange [page 54] to
Process Fl Posting Run (Process Step Outside of Scope Item Scope) [page 68] within this document
would be covered by this preconfigured process.

As mentioned in chapter Test Description, in this document we give in the More Information only a
high-level description of executing the payroll and post payroll processing within the Payroll Control Center.
Note that for a detailed description you can refer to the SAP Best Practices for SAP Payroll Processing
control center.

4.1 Execute Payroll Simulation Run

Purpose

The Payroll Administrator simulates payroll for individual employees or all employees before performing the
actual regular payroll run in the enterprise. He or she can also simulate payroll for individual employees at any
time during the regular payroll process to trace the cause of any errors.
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- Recommendation

We recommend that you run this during the pay period to identify and fix master and time data issues
before regular payroll is processed. In this way, sources of errors are recognized early in order to make
corrections before the regular payroll run.

Prerequisites

The employee must be hired, and master data maintained.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Log on as Access the Employee Central Payroll Menu and navi- The Payroll Driver
Payroll Ad- gate to |} Human Resources > Payroll > Americas > USA > Payroll (USA) screenis
ministrator displayed.

» Simulation J or enter transaction code PCOO_M10_CALC_SIMU.

2. Enter Pay-
roll Period
Data

Make following entries in the Payroll period section of the screen:
Payroll area: select UM(HR-US :Monthly) and choose Enter.

i Note

The payroll area from the previous step is provided as default.

Current period: The system displays the current period automatically.

i Note

The user should verify if the control record is set correctly. This
field checks the control record and determines the current pay
period. The current pay period is grayed out.

Other period: for simulation purposes, only, you may check the radio

button and enter the time period to process (other than the current
pay period).
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
3. Enter Selec- Make following entries in the Selection section of the screen:

tion Criteria

Personnel Number: For simulation purposes, only, you may also
enter valid personnel numbers. You can choose between individual
personnel numbers or a range of personnel numbers. Otherwise, leave
empty to run it for all employees in that payroll area.

i Note

In case of reruns, you might consider using the search help W.

Payroll area: If not defaulted, use value help to select UM(HR-
US:Monthly)

4. Enter Gen-
eral Pro-
gram Con-
trol Data

Make following entries in the General program control section of the
screen:

Reason for Payroll: leave empty unless processing an off-cycle payroll
Off-cycle payroll: leave empty unless processing an off-cycle payroll
Schema: YUSO

Forced retro.accounting as of: leave empty

Test run (no update): defined as default, cannot be changed

i Note

No update to the payroll results is produced. You can verify the
results in the Log display.

5. Enter Log
Display Op-
tion

Make following entries in the Log section of the screen:

Display Log: Flag the checkbox in case you want to verify the payroll
process in detail. The entire sequence of schema and rule processing
is displayed in the output log. Also, the operations and the individual
process steps are displayed.

A Caution

Productive runs should always have the Display Log field disabled,
since it produces a large print file and dramatically increases run-
time.

Display variant for log: You can only define a display variant after you
have run payroll and displayed the log. During log display, choose
Settings and make the appropriate settings for the log tree, detail
view, log search, and global parameters. Save this value as a variant.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
6. Enter Re- Select one of the following fields in the Remuneration statement
muneration parameters section of the screen:
Statement
Display variant Remun. Statement: check radio button if you want to
Parameters )
view the remuneration statement and enter YUS_HR_US_OC_M
No remuneration statement: check radio button if remuneration state-
ment is not required
7. Execute Choose the Execute pushbutton to begin payroll processing in test The Display Log
Test Payroll mode. Tree screenis dis-
Processing played.
8. View Pay If the Remuneration Statement option was selected, you can view the

Statement pay statement in the Display Log Tree screen. Proceed as follows:

® Incase the Display Log checkbox has been flagged, too, position
the cursor on the Successful personnel numbers in the Payroll Log
and select the Display Form icon. On the Display form for... dialog
box, flag the checkbox next to the employee(s) of interest and
choose the Copy (Enter) icon. On the Layout Set Display screen
the pay statements are displayed. Check them for correctness.

® Incase the Display Log checkbox has not been flagged, the
pay statements are displayed directly on the Layout Set Display
screen.

i Note

A variant for remuneration statement for each of the other payroll areas has been created, too, as part
of the activation program. Depending on the payroll area chosen, select for the Display variant Remun.
Statement field one of the following values:

®* YUS HR_US 0OC_SforUS (HR-US: Semi-monthly)

* YUS_HR_US_OC_WforUW (HR-US: Weekly)

®* YUS HR_US 0OC_XforUX (HR-US: Bi-weekly)

Result

Payroll results are simulated for the employee the pay period selected. A successful payroll run can be
determined as follows:

* The user can scroll down to the bottom of the payroll log and verify the total number of employees and
payroll periods that were processed successfully. The number of periods includes each retro period and as
such cannot be reconciled against the number of employees.
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In this case, continue in the process execution with process step Set Payroll Area [page 25] and
subsequent.

* |If there were any employees that did not process, they display under Rejected. These employees have an

error message associated to them in the Payroll log. This message helps you determine what changes must

be made to the employee record to allow the payroll program to successfully complete a result for the
employee. The only way to change the employee master record or time data is to release the payroll area
for correction.

In this case, continue in the process execution with process step Release Payroll Area for Correction
(Optional) [page 21] and subsequent.

4.2 Release Payroll Area for Correction (Optional)

Purpose

If in the payroll simulation run not all employees were processed correctly, the master data and/or time data
of these employees needs to be corrected. For this, the Payroll Administrator releases the payroll area for
correction first.

Prerequisites

The payroll simulation run was executed and revealed errors, and payroll control record is in Released f. Payroll
mode.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1 Logonas Accessthe Employee Central Pay- The Payroll area dialog box opens.
Payroll roll Menu and navigate to
Adminis- | uman Resources ¥ Payroll % Americas
trator

> USA > Payroll > Corrections } or enter
transaction code PCOO_M99 PAO3_CORR.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
2. Enter On the Payroll area dialog box, confirm the
Payroll payroll area that is set to corrections mode.
Area
3. Confirm  Choose Continue (Enter) to confirm the cor-  The employee records are now released for
Correc- rection of payroll. maintenance. The user can make necessary
tion Mode corrections to employee records. You return

to the Employee Central Payroll initial screen.

4.3 Correct Payroll-Relevant Master Data and/or Time Data
(Optional External Process Step)

Generic External Process Step

Purpose

The Payroll Administrator corrects master data or time data for personnel numbers that contain errors and
which the payroll program could not process.

Prerequisite

The payroll simulation run was executed and resulted in errors for some of the employees. The payroll control
record is in status Rel. f. Correction.

Procedure

Review the error message associated to the rejected employees in the Payroll log and correct the employee
data based on that message.

i Note

In case the Payroll Control Center is integrated in Employee Central, the alerts revealed by the Team
Monitoring preconfigured process are assigned to payroll administrator(s). The payroll administrator solves
the alerts. To achieve this, the procedure is as follows:
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* Logonto Employee Central as a Payroll Administrator.

* Select from the Home dropdown Payroll. You will be requested to enter your login data to the Employee
Central Payroll system.

* Gotothe My Alerts screen to check the errors assigned to you for solving.
* You can also go to the Unassigned Alerts screen to assign errors for solving to yourself.

* Solve the error; you can refer to the test script of scope item Manage Payroll Processes and Analyze
Payroll Anomalies Using the PCC from the SAP Best Practices for SAP Payroll Processing control
center.

4.4 Trigger Employee Master Data Replication (Optional)

Purpose

During payroll processing the replication of employees from the Employee Central system to the Employee
Central Payroll system is restricted. This is the case if one of the involved Employee Central Payroll payroll
areas is in status released for correction. So, in case employee(s) master data has been intentionally corrected
in Employee Central (like for example incorrect bank details in the payment information), the system stops
during the scheduled job in the middleware system the replication of the current employee. Instead, the HR
administrator needs to trigger the replication manually.

i Note

Employee master data that has been maintained directly in Employee Central using the mash-up Ul in
Employee Central is of course excluded from replication, as it is directly saved in Employee Central Payroll.

Prerequisites

Payroll control record is in status Rel. f. Correction and employee master data has been maintained in Employee
Central.
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Procedure

Test

Step Test Step Pass /
# Name Instruction Expected Result Fail

1. Log on Log on to Employee Central as an HR Administrator.  The Home page is displayed.

2. Go to Payroll

Select in the Home dropdown value Admin Center.
From the Company Processes & Cycles portlet select

The Data Replication Monitor

Replication screen is displayed, where the
Monitor I} Payroll > Data Replication Monitor 1 Replication Status tab is de-
faulted.
3. Search On the Replication Status screen flag the Failed Alist is displayed in the Standard
Failed Repli- checkbox. View part of the Data Replication
cations Monitor screen, containing all

Enter Selection Criteria, for example:

Replication Target System: select the appropriate Em-
ployee Central Payroll system from dropdown

Replication Content Type: select as appropriate from
dropdown, or leave as No Selection to obtain all
failed replications

Select other Selection Criteria as appropriate, or
leave asNo Selection

Check the appropriate <Replication Time> radio but-
ton.

When done, choose Apply.

employees of whom data replica-
tion has failed.

4. View Repli-
cation Error
Description

In the search result list go to the Extended View tab to
view the error description.

5. Trigger Em-

Select the employee(s) by flagging in the Select col-

A success message is generated

ployee Data umn the checkbox next to the employee’'s name and by the system and the data will
Replication  choose Send. be replicated to the payroll sys-
tem.
Result

The employee's master data record is updated automatically in the Employee Central Payroll system.
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4.5 Set Payroll Area

Purpose

The Payroll Administrator sets the payroll area for payroll run.

Prerequisites

Payroll control record must exist.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1 Log on as Access the Employee Central Payroll Menu and nav- The Payroll area dialog box
Payroll Ad- igate to |} Human Resources > Payroll > Americas opens.
ministrator )
> USA > Settings > Set payroll area ] or enter transac-
tion code PCOO_M99_ABKRS.
2 Enter Pay- On the Payroll area dialog box, choose the payroll area The payroll area of your choice
roll Area for payroll processing: is then used as default value for
Payroll area: select UM(HR-US :Monthly) further process steps, for exam-
ple, release payroll and exit pay-
roll.
3. Confirm Choose Continue to confirm the payroll area setting. You return to the Employee
Payroll Area Central Payroll initial screen.
Setting
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4.6 Release Payroll Area

Purpose

Once the Payroll Administrator has verified that all employee master data updates, time and salary information
are entered for a given period and has set the payroll control record for the appropriate period, he or she
releases the payroll area.

A payroll run cannot be performed until the payroll area has been released. Personnel numbers are always
released for payroll accounting areas. Releasing a payroll accounting area prevents changes related to either
the past or present from being made to master data and time data that is relevant to payroll accounting and
pertains to the released payroll accounting area. Master data changes that affect the future are still allowed.
This ensures that the payroll program takes account of all changes made to data that is relevant to payroll
accounting.

Prerequisites

Payroll control record must exist.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Log onas Access the Employee Central Payroll Menu and nav- The Release for payroll dialog
Payroll Ad-  joate to | Human Resources ¥ Payroll % Americas box opens.
ministrator )
} USA > Payroll > Release payroll ] or enter transaction
code PCOO_M99 PAO3_RELEA.
2. Confirm In the Release for payroll dialog box, choose Yes to con-  The selected payroll area has

Payroll Area firm that for the chosen payroll area, you want to release been released into the next pay

Release the period <period> for payroll. period (from the previous cur-
rent period to the current pe-
riod).
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4.7 Execute Payroll Run

Purpose

The Payroll Administrator executes the production payroll run for a selected payroll area for a certain pay
period.

The system accesses a country-specific payroll program. It determines the current payroll period from the
payroll control record and performs payroll using the values the Payroll Administrator entered in the payroll
program.

Prerequisites

The payroll area must have status Released f. Payroll if a production run is to be executed.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1 Log on as Access the Employee Central Payroll Menu and navigate to The Payroll Driver
Payroll Ad- | Hyman Resources ¥ Payroll % Americas ¥ USA ¥ Payroll ¥ Start ~ (USA) screenis
ministrator displayed.

payroll 3 or enter transaction code PCOO_M10_CALC.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
2. Enter Pay-  Make following entries in the Payroll period section of the screen:
roll Period
Payroll area: select UM(HR-US :Monthly)
Data
i Note
The value from the previous step is provided as default.
Current period: The system displays the current period automatically.
i Note
The user should verify if the control record is set correctly. This
field checks the control record and determines the current pay
period. The current pay period is grayed out.
Other period: leave empty
3. Enter Selec- Make following entries in the Selection section of the screen:
tion Criteria
Personnel Number: leave empty to run it for all employees in the
payroll area
Payroll area: use value help to select UM(HR-US :Monthly)
A Caution
You should only run one payroll area at a time!
4. Enter Gen- Make following entries in the General program control section of the
eral pro- screen:
ram con-
g Reason for payroll: leave empty unless processing an off-cycle payroll
trol Data
Off-cycle payroll: leave empty unless processing an off-cycle payroll
i Note
In case you have entered a reason for payroll, enter also the type
of off-cycle and the date for which off-cycle payroll is run.
Schema: YUSO
Forced retro.accounting as of: leave empty
Test run (no update): leave unchecked
Payroll and Post Payroll Processing: Test Script
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Test
Step Test Step
# Name

Instruction Expected Result

Pass /
Fail

5. Enter Log

Make following entries in the Log section of the screen:

Display Op-
_I play Op Display log: leave blank
tion
Display log for time management additionally: leave blank
Display variant for log: You can only define a display variant after you
have run payroll and displayed the log. During log display, choose
Settings and make the appropriate settings for the log tree, detail
view, log search, and global parameters. Save this value as a variant.
6. Enter Re- In the Remuneration statement parameters section of the screen, se-
muneration lect one of the following fields:
Statement
Display variant Remun. Statement: leave unchecked
Parameters
No remuneration statement: check radio button
7. Execute Choose the Execute pushbutton to begin payroll processing in produc- The Display Log
Payroll tive mode. Tree screen is dis-
Processing played.
Result

The production payroll run is executed. A successful payroll run is determined if:

* The user can scroll down to the bottom of the payroll log and verify the total number of employees and
payroll periods that were processed successfully.
In this case, continue in the process execution with process step View Payroll Results [page 36] and

subsequent.

¢ If there were any employees that did not process, they display under Rejected.
In this case, continue in the process execution with process step Release Payroll Area for Corrections
(Optional) [page 30] and subsequent.
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4.8 Release Payroll Area for Corrections (Optional)

Purpose

In case not all employees within a payroll area were processed successfully in the payroll run (see details
described in the previous process step), the Payroll Administrator needs to perform corrections to the master
data and/or time data of the employees that were rejected by the payroll run.

The employees that did not complete successfully the payroll run have an error message associated to them in
the Payroll log. This message helps the Payroll Administrator to determine what changes must be made to the
employee record to allow the payroll program to successfully complete a result for the employee. The only way
to change the employee master record or time data is to release the payroll area for correction.

Prerequisites

The payroll run was executed, and payroll control record has status Released f. Payroll.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1 Log on as Access the Employee Central Payroll Menu and nav- The Payroll area dialog box
Payroll Ad- igate to |} Human Resources > Payroll > Americas opens.
ministrator
> USA > Payroll > Corrections } or enter transaction
code PCOO_M99 PAO3_CORR.
2. Enter Payroll  On the Payroll area dialog box, confirm the payroll
Area area that is set to corrections mode.
3. Confirm Cor-  Choose Continue (Enter) to confirm the correction of The employee records are now
rection Mode payroll. released for maintenance. The

user can make necessary cor-
rections to employee records.
You return to the Employee
Central Payroll initial screen.
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4.9 Correct Payroll-Relevant Master Data and/or Time Data
(Optional External Process Step)

Generic External Process Step

Purpose

The Payroll Administrator corrects master data or time data for personnel numbers that contain errors and
which the payroll program could not process.

Prerequisite

The payroll run was executed and resulted in errors for some of the employees.

Procedure

Review the error message associated to the rejected employees in the Payroll log and correct the employee
data based on that message.

i Note

In case the Payroll Control Center is integrated in Employee Central, the alerts revealed by
the Production Payroll preconfigured process are assigned to payroll administrator(s). The payroll
administrator solves the alerts. To achieve this, the procedure is as follows:

* Logonto Employee Central as a Payroll Administrator.

* Select from the Home dropdown Payroll. You will be requested to enter your login data to the Employee
Central Payroll system.

* Gotothe My Alerts screen to check the errors assigned to you for solving.
* You can also go to the Unassigned Alerts screen to assign errors for solving to yourself.

* Solve the error; you can refer to the test script of scope item Manage Payroll Processes and Analyze
Payroll Anomalies Using the PCC from the SAP Best Practices for SAP Payroll Processing control
center.
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4.10 Trigger Employee Master Data Replication (Optional)

Purpose

During payroll processing the replication of employees from the Employee Central system to the Employee
Central Payroll system is restricted. This is the case if one of the involved Employee Central Payroll payroll
areas is in status released for correction. So, in case employee(s) master data has been intentionally corrected
in Employee Central (like for example incorrect bank details in the payment information), the system stops
during the scheduled job in the middleware system the replication of the current employee. Instead, the HR
administrator needs to trigger the replication manually.

i Note

Employee master data that has been maintained directly in Employee Central using the mash-up Ul in
Employee Central is of course excluded from replication, as it is directly saved in Employee Central Payroll.

Prerequisites

Payroll control record is in status Rel. f. Correction and employee master data has been maintained in Employee
Central.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1 Log on Log on to Employee Central as an HR Administrator. The Home page is displayed.
2. Go to Payroll Select in the Home dropdown value Admin Tools. From The Data Replication
Replication o company Processes & Cycles portlet select | Payroif ~ Monitor screenis displayed,

Monitor o ) where the Replication Status
> Data Replication Monitor ] )
tab is defaulted.
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Test
Step Test Step Pass /
# Name Instruction Expected Result Fail

3. Search Failed On the Replication Status screen flag the Failed checkbox. A list is displayed in the

Replications ) L Standard View part of the
Enter Selection Criteria, for example: S )
Data Replication Monitor
Replication Target System: select the appropriate screen, containing all em-
Employee Central Payroll system from dropdown ployees of whom data repli-

Replication Content Type: select as appropriate from cation has failed.

dropdown, or leave as No Selection to obtain all
failed replications

Select other Selection Criteria as appropriate, or leave as
No Selection

Check the appropriate <Replication Time> radio button.

When done, choose Apply.

4. View Replica- Inthe search result list go to the Extended View tab to
tion Error view the error description.
Description

5. Trigger Em-  Select the employee(s) by flagging in the Select column A success message is gener-
ployee Data the checkbox next to the employee’'s name and choose ated by the system and the
Replication  Send. data will be replicated to the

payroll system.
Result

The employee's master data record is updated automatically in the Employee Central Payroll system.

4.11 Release Payroll Area for Payroll Correction Run
(Optional)

Purpose

After performing corrections to the master data and/or time data of the employees that were rejected by the
payroll run, the Payroll Administrator releases the payroll area again in order to perform the payroll correction
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run. The personnel numbers in the payroll area are again locked for past and present changes to the master
and time data.

Prerequisites

The errors that led to the failure of the payroll run for these employees have been corrected.

Payroll control record must exist.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1 Log on as Access the Employee Central Payroll Menu and nav- The Release for payroll dialog
Payroll Ad-  joate to |B Human Resources ¥ Payroll % Americas box opens.
ministrator
> USA > Payroll } Release payroll ] or enter transaction
code PCOO_M99 PAO3_RELEA.
2. Confirm In the Release for payroll dialog box, choose Yes to con-  The payroll area has been re-

Payroll Area firm that for the chosen payroll area, you want to release leased and the payroll correc-
Release the period <period> for payroll. tion run can be executed.

4.12 Execute Payroll Correction Run (Optional)

Purpose

The Payroll Administrator performs a payroll correction run.

- Recommendation

If there are many employees stored in search help W (Payroll correction run), perform this step as a
background job in the same way that you performed the Execute Payroll Run step. If you only have to run
payroll again for a few employees, you can perform this step online.
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Prerequisites

The system has stored personnel numbers not included in the payroll run due to incorrect data in match code
W (Payroll correction run). The Payroll Administrator has performed corrections for the relevant employees and
finally released payroll a second time.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Logonas Access the Employee Central Payroll Menu and nav- The Payroll Driver (USA)
Payroll Ad-  joate to |p Human Resources ¥ Payroll % Americas ¥ USA ~ Screenis displayed.
ministra- )
tor > Payroll > Start payroll ] or enter transaction code

PCOO_M10_CALC.

2. Enter Pay- Make following entry in the Payroll period section of the
roll Area screen:

Payroll area: select UM(HR-US :Monthly)

3. Select Choose Search helps and select match code W (Payrol 1 The Restrict Value Range di-
Matchcode correction run). Matchcode W contains all employees — alog box opens.
w that were rejected during the payroll run.

4. Select Em- In the Restrict Value Range dialog box, specify an individual
ployee personnel number or an interval of personnel numbers. Only

the personnel numbers corresponding to these values are se-
lected from the payroll correction run. Choose the Continue

pushbutton.

5. Execute Choose Program from the Menu on top of the screen. The payroll correction run
Payroll There select either Execute or Execute and Print has been executed. The em-
Correction or Execute in Background, depending on your scope. Ployee's pay for the chosen
Run pay period has been calcu-

lated.

A Caution

If errors occur a second time, repeat all process steps starting with Release Payroll Area for Corrections to
Execute Payroll Correction Run until payroll has been performed for all personnel numbers and Matchcode
W is empty. You can only end the payroll run when match codeW no longer contains any personnel
numbers!
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4.13 View Payroll Results

Purpose

The Payroll Administrator can view the history of payroll results for any payroll periods run at any time.

Prerequisites

The payroll run was executed, and payroll results were generated.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1 Log on as Access the Employee Central Payroll Menu and nav- The Display payroll results
Payroll Ad- igate to |F Human Resources # Payroll  Americas screenis displayed, which is div-
ministrator ided in three parts.

> USA > Tools > Display Results } or enter transaction
code PC_PAYRESULT.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
2. Select Em-  Inthe Selection part of the screen, enter the employ- In the Personnel numbers
ployee(s) ee's personnel number: selected part located on the left-
Personnel number: <employee’s personnel hand side of the screen, the em-
number> ployees you have selected are
listed.
i Note
The symbol in the Res. (mean-
You can use also the Multiple selection pushbutton  ing Payroll results available)
next to the Personnel number field to select sev- column of the table shows if
eral employees. there are results available in the
selected period:
Optionally, you can specify th§ date starting with which the green square means
the payroll results should be displayed: Payroll results available:;
all results from: <payroll result start * the red circle means No
date> Payroll Results Exist;
i Note the grey rhombus means
that you have no authoriza-
If you leave this field blank, all existing payroll re- tion to view payroll results.
sults for the selected employee will be displayed.
When done, choose Transfer (Enter).

3. Select Em-  Inthe Personnel numbers selected part of the screen,  In the Payroll Results <employee
ployee with  select an employee for whom payroll results exist. name / country> part located
Payroll Re- on the right-hand side of the
sults screen, the existing payroll re-

sults for the selected employee
are displayed.

4. Select Pay- Select the payroll period and choose the Display The system displays the list of all
roll Result Overview icon. tables of the payroll result that
for Payroll are relevant to the country of
Period the employee, and the number

of entries per table.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
5. Select Table To view details to the displayed tables, select a table The Tables / field strings of
to View from the list and choose the Display Contents pushbut- payroll result screen is displayed.
ton.
Especially, view the details of tables RT and BT.
i Note
Instead of choosing the Display Contents pushbut-
ton, you can also double-click the selected table.
Note that the Display Contents has the same icon
as the Display Overview mentioned in test step #
4,
6. View Table  On the Tables / field strings of payroll result screen, you The employee payroll results
Content can view details of the selected table. Make sure that have been viewed for the se-

the displayed results are correct. lected payroll period.

i Note

The table RT (meaning Results Table) contains all
wage types to be processed. You have to make
sure the wage types are correct. You can achieve
this with the reconciliation or wage type reporter
report.

i Note

The table BT contains the payment information for
the employee.

4.14 Delete Payroll Results (Optional)

Purpose

Payroll results rarely need to be deleted, but the Payroll Administrator can delete results if required.

A\ Caution

In production systems, this should not be allowed and only performed via a certain emergency user ID.
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If payroll has been performed for an employee who should not have been included in the payroll run or for
whom payroll should have been run differently (for example, if the system has performed a retroactive run too
far in the past), the Payroll Administrator can delete the payroll result.

A\ Caution

Only the last payroll result can be deleted.

A payroll result can be deleted only in the following cases:

* The employee's master data are no longer processed.

* Payment was not yet arranged for the employee. In this case, correct the payroll error and rerun payroll.

A Caution

If you are working in a live system, the payroll control record for the payroll area that the employee belongs
to should not yet have the status Exit payroll!

Prerequisites

The payroll run was executed, and payroll results were generated.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1 Log on as Access the Employee Central Pay- The Delete current payroll result screen is dis-
Payroll Ad- roll Menu and navigate to |} Human played.
ministrator .
Resources > Payroll > Americas > USA
> Tools > Problem Solving > Delete
Payroll Result } or enter transaction code
PUO1.
2. Select Em-  Enter the personnel number of the em-
ployee ployee and choose Execute.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
3. Confirm Choose Delete to confirm the deletion of ~ The employee payroll results have been de-

Payroll Re-  the payroll result. leted. The previous payroll result becomes the

sult Dele- current payroll result. The Payroll Status in-

tion fotype (ITOO03) is updated accordingly. The

deletion of the payroll result is saved in the
application log. You can use the application
log to view the deleted payroll results. .

4.15 Execute Fl Posting Simulation Run

Purpose

The Payroll Administrator performs a posting simulation run to Financial Accounting.

During the simulation run, the system tests the posting run for accuracy, it balances and verifies the accounts.
If everything is correct, posting to accounting in production mode can be performed.

- Recommendation

A simulation of a posting run should be executed for each period before exiting payroll. In this way,
posting-relevant errors in the payroll results can be recognized early and errors avoided when creating a live
posting run. The simulation and live run are executed using the same transaction below.

i Note

To run a production posting run, the control record must be in status Exit Payroll. For simulation runs, you
can leave the control record in status Rel. f. Correction.
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Procedure

Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Logonas Access the Employee Central Payroll Menu and nav- The Posting to
Payroll igate to | Human Resources  Payroll  Americas ¥ USA Accounting: Create
Adminis- o ) ) ~ Posting Run screenis
> Subsequent activities > Per payroll period > Evaluation > Posting .
trator displayed.
to accounting > Execute posting run } or enter transaction code
PCOO_M99_CIPE.
2. Enter Make following entries in the Payroll Period section of the screen:
Payroll ) I .
Period Period: Current Payroll Period is defaulted; for sim-
erio
Data ulation purposes, only, you may select Other Payroll
Period from the dropdown and enter in the second Period field
the time period to process.
Payroll Area: select UM(HR-US :Monthly) and choose Enter.
3. Enter Se- Make following entries in the Selection Criteria section of the
lection screen:
Criteria

Personnel Number: For simulation purposes, only, you may also
enter valid personnel numbers. You can choose between individ-
ual personnel numbers or a range of personnel numbers. Other-
wise, leave empty to run it for all employees in that payroll area.

Payroll area: If not defaulted, use value help to select UM(HR-
US:Monthly)

A Caution

Select the same value as in the Payroll Period section. Do not
use payroll area ranges.
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Test
Step Test Step
# Name

Instruction Expected Result

Pass /
Fail

4. Enter Run
Attributes

Make following entries in the Run Attributes section of the screen:

Off-Cycle Payroll Run: leave empty unless processing an off-cycle
payroll

Type of document creation: select S(Creation of
simulation documents) from value help

Output log: flag the checkbox in case you want to obtain a results
log for all selected employees

i Note

In case you leave the checkbox unflagged, a log will only be
output for the rejected employees.

Text on posting run: enter text to identify the posting document, if
appropriate

5. Specify In the Specify posting date section of the screen, check the Acc. to
Posting Payment Date radio button.
Date

6. Enter Make following entries in the Data for document creation section
Docu- of the screen:
mt.ant Cre- Document Date: select from calendar help, or leave empty to de-
ation fault to today’s date
Data

Posting variant: SAP

7. Execute FI Choose the Execute pushbutton. The Evaluation of
Posting Posting Item screen is
Simula- displayed.
tion Run

s Go to On the Evaluation of Posting Item screen, choose the Document The Posting to
Simula- Overview pushbutton. Accounting: Document
tion overview screen is
Docu- displayed, containing
ment the created simulation

document, together
with its status, listed in

atable.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
9. View Line To view the line items of the document, flag the appropriate The Display Payroll

Items of  checkbox in the Document column and choose the Display line Posting Document

Simula- items pushbutton. screen is displayed,

tion containing the detailed

Docu- -> Recommendation posting document.

ment

Viewing the line items of the document makes sense when
this document has status Incorrect. In this case, you can view
the appropriate error messages and solve the issues before
performing a productive financial accounting posting run.

i Note

As the Accounting configuration is not in scope of this SAP
best practices, no posting documents will be generated.

4.16 Execute Third-Party Remittance Simulation Run

Purpose

Payroll has been completed and the Payroll Administrator is ready to simulate the third-party remittance run.
Third-Party Remittance extracts vendor payment data from Payroll results for various employee deductions.

The Payroll Administrator uses the third-party remittance evaluation report to evaluate and update the third-
party remittance tables for the organization. He or she will initially run the update in test mode to check which
data will be updated in the productive run.

Prerequisites

Payroll results must exist for the employees for which the third-party remittance process is to be executed.
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Procedure

Test
Step Test Step
# Name

Pass /
Instruction Expected Result Fail

1 Log on as Pay-
roll Adminis-
trator

Access the Employee Central Payroll Menu and navi- The Create Third-Party

gate to | Human Resources ¥ Payroll % Americas  USA ~ Remittance Evaluation

L o . Run screen is displayed.
> Subsequent activities > Period-independent > Evaluation

> Third-party remittance > Evaluate remittance (New) } or
enter transaction code PCOO_M99_URME.

2. Enter Payroll
Period Data

On the Create Third-Party Remittance Evaluation Run
screen, make following entries in the Payroll Period section:

Period: Current Payroll Period isdefaulted;

for simulation purposes, only, you may select Other
Payroll Period fromthe dropdown and enter in the
second Period field the time period to process.

Payroll Area: select UM(HR-US :Monthly) and choose
Enter.

3. Enter Selec-
tion Criteria

On the Create Third-Party Remittance Evaluation Run
screen, make following entries in the Selection Criteria sec-
tion:

Personnel Number: For simulation purposes, only, you
may also enter valid personnel numbers. You can choose
between individual personnel numbers or a range of per-
sonnel numbers. Otherwise, leave empty to run it for all
employees in that payroll area.

Payroll area: If not defaulted, use value help to select
UM(HR-US:Monthly)

i Note

Select the same value as in the Payroll Period section.
Do not use payroll area ranges.

4. Enter Off-Cycle
Payroll Proc-
essing Data
(Optional)

Off-cycle reason: leave empty unless processing an off-cy-
cle payroll

Off-cycle Payroll Processing: leave empty unless processing
an off-cycle payroll
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Test

Step Test Step Pass /

# Name Instruction Expected Result Fail

5. Enter HR On the Create Third-Party Remittance Evaluation Run
Payee Type screen, make following entries in the HR payee type to be

posted section:
HR payee type: select from value help, or leave empty to
obtain all available HR payee items

i Note

You can select several values.

6. Enter Control  On the Create Third-Party Remittance Evaluation Run

Data screen, make following entries in the Control data section:
Check the appropriate radio button in the ALV control part,
for example Grid view.

Flag the appropriate checkbox(es) in the Level of detail on
double-click part.
Flag the checkbox in the Detail for list output part, if appro-
priate.
Check the Test Mode radio button.
i Note
No update of any corresponding database table is per-
formed.
Display log: flag the checkbox in case you want to verify the
detailed log.

7. Execute Test Choose the Execute pushbutton. A new screen is dis-
Third-Party Re- played, containing the
mittance Eval- log of the remittance
uation evaluation simulation

run.

8 View Results of Choose the Back pushbutton. On the upcoming Remittance

. . evaluation run - Overview screen, view details of the HR

Simulation ) ) Lo
payee items based on the selection criteria you have en-

Run tered. You have different options to display the results. For
example, you can use the Display table icon to view details
as per your requirements.
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4.17 Create Test Payment Data Using Preliminary Program
Data Medium Exchange

Purpose

The Payroll Administrator uses the preliminary program Data Medium Exchange (DME for short) to evaluate
the payroll results in order to create test payment data.

Prerequisites

The payroll run was executed successfully and a Bank Transactions (BT) cluster is generated in payroll for the

employee.

Procedure

Test

Step Test Step Pass /

# Name Instruction Expected Result Fail

1. Log onas Access the Employee Central Payroll Menu and navigate to The Data Medium
Payroll Ad- | 1man Resources ¥ Payroll % Americas % USA ¥ Payroll ~ Exchange Preliminary
ministrator Program (USA) screen is

¥ Bank transfer ¥ Pre-program DME 4 or enter transaction
code PCOO_M10_CDTC.

displayed.

2. Enter Pay-
roll Period
Data

Make following entries in the Payroll Period section of the
screen:

Payroll Area: select UM(HR-US :Monthly)

Period: check either Current period or Other period radio but-

ton (and enter appropriate value)
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
3. Enter Selec- Make following entries in the Selection section of the screen:

tion Criteria

Personnel Number: enter all valid personnel numbers or leave
empty to run the program for all employees in the payroll area

i Note

You can choose between individual personnel numbers or
a range of personnel numbers.

Payroll area: select UM(HR-US :Monthly)
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Test

Step Test Step

#

Name

Instruction Expected Result

Pass /
Fail

Enter Addi-
tional Data

Make following entries in the Additional data section of the
screen:

Special run: leave blank unless running an off-cycle payroll run
(in this case enter off-cycle payroll run type, number, and date
if appropriate)

Wage type: leave blank unless running program for one bank
transfer wage type

Payment Method: leave blank
Test: flag checkbox
Set flag for transfers: checked by default

Repeat run: Date: leave blank

i Note

If the program needs to be run again, you have to retrieve
the date and timestamp from cluster RU table BT and
enteritin here.

(Repeat run): Time: leave as is

Flagged records only: leave unchecked

Payroll form: defaults to UFO1/A /X/J3/1/B/ /;leave asis

Payroll form for check: defaults to UFO1/A /X/J/1/B/ /,
leave as is

Payslip on pay advance note: flag checkbox to print remunera-
tion statement for employees receiving a transfer

Payroll form for advice: defaults to
UFO1/A /X/J3/1/B/ /;leaveasis

Log: check one of the radio buttons: List, Tree (Summary),
Tree (Details)

i Note

Radio button List is checked by default.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
5. Execute Choose Execute. A payment test run has

Test Run been created by the pre-

liminary program DME
that contains payment
data for all allowable pay-
ment methods.

6. View Output On the Data Medium Exchange Preliminary Program (USA)
screen review the output of the test run.

i Note

Sample variants for each payroll area have been delivered as part of the activation content.

Instead of executing test steps # 2 to # 4 you can choose on the Data Medium Exchange Preliminary
Program (USA) screen the Get Variant ... icon and select the appropriate variant name, as follows:

* for payroll areaUM (HR-US: Monthly) select variant YUS_HR_US_OC_M

* for payrollareaUS (HR-US: Semi-monthly) selectvariant YUS_HR_US OC_S

* for payrollareaUW (HR-US: Weekly) select variant YUS_HR_US_OC_W

* for payrollareaUX (HR-US: Bi-weekly) selectvariant YUS_HR_US 0OC_X

Flag the Test checkbox and then continue with test step # 5 from the table above.

4.18 Exit Payroll

Purpose

Once all personnel numbers have been processed successfully (or their results deleted, and their status set to
locked), and payroll accounting is done for each of them, the Payroll Administrator exits the payroll program.
Exiting the payroll program means that the payroll period is complete for the selected payroll accounting area.

A Caution

This step concludes the payroll process and allows the Payroll Administrator to run afterwards posting
to accounting in production mode. All employee data relevant for payroll must have been verified and
corrected before payroll is exited. This step is critical, since after posting to accounting or running bank
transfer, there is no way to go back to the status Released f. Payroll for the current pay period.
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Prerequisites

The payroll run must have been executed without errors.
The Pre-DME test runs are completed.

Posting simulation run to finance was error free.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Log on as Access the Employee Central Payroll The Exit Payroll dialog box opens.
Payroll Ad- 1oy and navigate to |- Human Resources
ministrator
> Payroll > Americas > USA > Payroll > Exit
payroll } or enter transaction code
PCO0_M99_PAO3_END.
2. Confirm In the Exit payroll dialog box choose Yes to The payroll period has now been closed

Payroll Area confirm the payroll area to exit.
Exit

and no further processing can occur. The
payroll period is incremented in the payroll
control record and the payroll accounting
area is released for further processing.

4.19 View Remuneration Statement

Purpose

The HR Administrator views an employee's remuneration statement. He or she can do this using the mashup

Ul in SAP SuccessFactors Employee Central.

Prerequisites

The payroll run was executed successfully, and the payroll results are generated for all employees.
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In order to access the Employee Central Payroll system directly from Employee Central via mash-up, the
services Masterdata Maintenance Application and NetWeaver Business Client need to be activated and
certain permissions need to be granted to the HR Administrator.

i Note

Refer to Configuration Guide - Getting Started for more details.

Procedure

A Caution

When describing the procedure of executing this process step, we consider that People Profile is enabled
in the Employee Central instance.

In case People Profile is not enabled in your Employee Central instance, pay attention that the navigation
path might differ with respect to the one mentioned in this document!

Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Log on Log on to Employee Central as an HR The Home page is displayed.
Administrator.
2. Search In the Search for actions or people box, in the top The autocomplete functionality sug-
Em- right corner of the screen, enter the name (or name gests a list of employees matching

ployee parts) of the employee for whom you want toview  your search criteria.
the remuneration statement.

3. Select Select the appropriate employee from the result You are directed to the Employee Files
Em- list. page in which the profile of the em-
ployee ployee is displayed.

4. Go to Go to the Employment Information section and The Payroll Information subsection
Payroll there scroll to the Payroll Information subsection. is displayed. It contains following
Informati blocks: Tax, Earnings and Deductions,
on sub- Garnishments, Additional Employer
section Benefits, and Others.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
5. Select In the Earnings and Deductions block select the Pay  You are linked to Employee Central
Pay Statement link. Payroll, where you need to enter logon
Statemen details.
t

The screen, which shows up, is divided
into two parts:

® Inthe left part, the pay periods
are listed, for which remuneration
statements are available.

® Intheright part of the screen, the
embedded remuneration state-
ment for the first pay period, as
available in the left part of the
screen, is displayed.

6. View Re- Choose the pay period for which you want to view The embedded remuneration state-
munera- the remuneration statement by choosing it in the ment for the chosen pay period, as
tion left part of the screen. available in the left part of the screen,
State- is displayed.
ment

Check the remuneration statement of the employee
for correctness.

If needed, you can print the remuneration state-
ment. For this, choose the Print File icon visible
when hovering the mouse over the form.

4.20 View my Remuneration Statement

Purpose

The Employee views his or her own remuneration statement. He or she can do this using the mashup Ul in SAP
SuccessFactors Employee Central.
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Prerequisites

The payroll run was executed successfully, and the payroll results are generated for all employees.

In order to access the Employee Central Payroll system directly from Employee Central via mash-up, the
services Masterdata Maintenance Application and NetWeaver Business Client need to be activated and
certain permissions need to be granted to the Employee.

i Note

Refer to Configuration Guide - Getting Started for more details.

Procedure

A\ Caution

When describing the procedure of executing this process step, we consider that People Profile is enabled
in the Employee Central instance.

In case People Profile is not enabled in your Employee Central instance, pay attention that the navigation
path might differ with respect to the one mentioned in this document!

Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Log on Log on to Employee Central as an Employee. The Home page is displayed.
2. Select From the Home dropdown, select My Employee The My Employee File screen is dis-
Employee File. played containing your profile.
File
3. Go to Go to the Employment Information section and The Payroll Information subsection is
Payroll there scroll to the Payroll Information subsection. displayed. Depending on the permis-
Informatio sions granted, different blocks are visi-
n subsec- ble.
tion
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
4. Select Pay Inthe Earnings and Deductions block select the Pay You are linked to Employee Central
Statement Statement link. Payroll, where you need to enter logon
details.

The screen, which shows up, is divided
into two parts:

® Inthe left part, the pay periods
are listed, for which remuneration
statements are available.

® Intheright part of the screen, the
embedded remuneration state-
ment for the first pay period, as
available in the left part of the
screen, is displayed.

5. View Re-  Choose the pay period for which you want to view  The embedded remuneration state-
munera-  the remuneration statement by choosing it in the ment for the chosen pay period, as
tion left part of the screen. available in the left part of the screen,
State- is displayed.
ment

Check your remuneration statement for correct-

ness.

If needed, you can print the remuneration state-
ment. For this, choose the Print File icon visible
when hovering the mouse over the form.

4.21 Create Payment Data Using Preliminary Program Data
Medium Exchange

Purpose

The Payroll Administrator uses the preliminary program Data Medium Exchange (DME for short) to evaluate
the payroll results in order to create payment data. The creation of payment data is the first step in the actual
net payments process.
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Prerequisites

The payroll run was executed successfully, and a Bank Transactions (BT) cluster is generated in payroll for the

employee.
Procedure
Test
Step Pass /
# Test Step Name Instruction Expected Result Fail
1 Log on as Payroll Access the Employee Central Payroll Menu and navigate to The Data
Administrator |} Human Resources > Payroll > Americas > USA > Payroll Medium Exchange
) Preliminary
> Bank transfer > Pre-program DME } or enter transaction code
Program (USA)
PCOO_M10_CDTC. .
- - screen is displayed.
2. Enter Payroll Pe- Make following entries in the Payroll Period section of the
riod Data screen:
Payroll area: select UM(HR-US :Monthly)
Period: check Current period radio button
3. Enter Selection  Make following entries in the Selection Criteria section of the
Criteria screen:
Personnel Number: leave empty to run the program for all em-
ployees in the payroll area
Payroll area: select UM(HR-US :Monthly)
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Test
Step
#

Test Step Name

Instruction Expected Result

Pass /
Fail

4.

Enter Additional
Data

Make following entries in the Additional data section of the
screen:

Special run: leave blank unless running an off-cycle payroll run
(in this case enter off-cycle payroll run type, number, and date
if appropriate)

Wage Type: leave blank unless running program for one bank
transfer wage type

Payment Method: leave blank
Test: leave unchecked
Set flag for transfer: checked by default

Repeat run: Date: leave blank

i Note

If the program needs to be run again, you have to retrieve
the date and timestamp from cluster RU table BT and
enteritin here.

(Repeat run): Time: leave as is
Flagged records only: leave unchecked
Payroll form: defaults to UFO1/A /X/J3/1/B/ /;leave asis

Payroll form for check: defaults to UFO1/A /X/3/1/B/ 7/,
leave as is

Payslip on pay advance note: flag checkbox to print remunera-
tion statement for employees receiving a transfer

Payroll form for advice: defaults to UFO1/A /X/J/1/B/ /,
leave as is

Log: radio button List checked by default; leave as is

5.

Generate Run
File Identifica-
tion Feature

Choose Execute.
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Test
Step Pass /
# Test Step Name  Instruction Expected Result Fail

6. Note Down Iden- On the Data Medium Exchange Preliminary Program (USA)
tification Feature screen, make note of the identification feature. This is used in
the following steps to generate the check and Payroll Payment
file to the bank.

i Note

The identification feature is displayed in the Program run
date part of the screen together with the date of the pro-
gram run.

i Note

Sample variants for each payroll area have been delivered as part of the activation content.

Instead of executing test steps # 2 to # 4 you can choose on the Data Medium Exchange Preliminary
Program (USA) screen the Get Variant ... icon and select the appropriate variant name as follows:

* for payrollareaUM (HR-US: Monthly) select variant YUS HR_US_OC_M

e for payrollareaUS (HR-US: Semi-monthly) select variant YUS_HR _US OC_S

* for payrollareaUW (HR-US: Weekly) select variant YUS_HR_US_OC_W

* for payrollareaUX (HR-US: Bi-weekly) select variant YUS_HR_US 0OC_X

Continue with test step # 5 from the table above.

Result

A payment run has been created by the preliminary program DME that contains payment data for all allowable
payment methods. Every payment run can be clearly identified using a combination of the Program Run

Date and Identification Feature. The Identification Feature originates from the six-digit system time when the
preliminary program DME has been started by the payroll administrator. The system replaces the last digit of
the six-digit system time in the Identification Feature with Payroll results simulated for employee for the pay
period selected.

«»» Example

For example, the preliminary program DME was run at 09/25/12 on 04/14,/2000. You can clearly identify
the payment run created using a combination of the Program Run Date (04/14/2000) and Identification
Feature (09251P).
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4.22 Create Direct Deposit Test File

Purpose

The Payroll Administrator creates the direct deposit test file to check the correctness of the data that will be
transferred after a productive run to the bank of the employee.

Prerequisites

The payroll run is executed, and payroll results are generated for all employees. The preliminary program DME

has been run.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Log onas Access the Employee Central Payroll Menu and The Payment Medium:
Payroll Ad- 5 igate to |B Human Resources ¥ Payroll % Americas Creation screen is dis-
ministrator played.
> USA > Payroll > Bank transfer > Create DME-Payment
Medium Workbench ] or enter transaction code
PCOO_M99_ FPAYM.
Payroll and Post Payroll Processing: Test Script
58 PUBLIC Test Procedures



Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
2. Enter Data  On the Payment Medium: Creation screen, make the following
entries:
Run Date: use match code from dropdown list
Identification: is filled when the choice is made for the Run
Date field with the identification feature noted in the previous
process step
Proposal run: flag checkbox
Payment Medium Format: select ACH(Domestic
payment transactions USA) and choose Enter.
i Note
Format of file sent to the bank. Per NACHA rules, this
must be a PPD format.

3. Choose For- Inthe Format section of the screen, choose Format The Other specifications
mat Param- Parameters. for payment medium
eters format ACH dialog box is

iNote displayed.
This button shows up once you have entered value ACH
in the Payment Medium Format field.

4. Enter For- On the Other specifications for payment medium format ACH
mat Param- dialog box, make following entries:
eters L

ACH Batch hdr. Company entry description: enter O1
Company identification: leave blank
Select Continue (Enter).
5. Enter Print  In the Print Control section of the screen, make following
Control entries:
Data )
Data Medium Exchange: flag checkbox to output the DME
message
Payment Summary: flag checkbox to output the payment
summary
Error Log: flag checkbox to output the error log
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
6. Enter Out-  Inthe Output Control section of the screen, make following
put Control entries:
Data . .
Payment Document Validation: flag checkbox to validate the
document
Output to file system: flag checkbox if you want to save the
file on the application server; else leave blank
File name: in case you have flagged checkbox Output to file
system, enter <File name>; else leave empty
Form Type: defaults to SAPscript; leave as is.
Form Accompanying Letter: leave empty
Payment Summary Layout: leave empty
Screen Output: flag checkbox
7. Generate Choose Execute to generate the DME file. The system displays an
Test File overview of the generated
payment medium.
i Note

60

Sample variants for each payroll area have been delivered as part of the activation content.

Instead of executing test steps # 2 to # 6 you can choose on the Data Medium Exchange Preliminary

Program (USA) screen the Get Variant ... icon and select the appropriate variant name, as follows:

* for payrollareaUM (HR-US: Monthly) select variant YUS_HR_US _OC_M

* for payroll areaUS (HR-US: Semi-monthly) select variant YUS_HR_US_OC_S
* for payrollareaUW (HR-US: Weekly) select variant YUS_HR _US OC_W

* for payrollareaUX (HR-US: Bi-weekly) select variant YUS_HR_US OC_X

Select the Run Date using match code from dropdown list; the Identification field is then filled

automatically. Flag the Proposal run checkbox.

Continue with test step # 7 from the table above.
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4.23 Create Direct Deposit File

Purpose

The Payroll Administrator generates the direct deposit file to send to the bank.

Employees who elect to have their payroll funds by Direct Deposit are paid with this process. The disbursement
bank that issues payroll for your company requires a file from the Employee Central Payroll system that states
all pertinent information in standard ACH format. This information includes data regarding the payee's name,
payroll period, dates of payment, and net payments.

The program creates the ACH file, the DME accompanying sheet, and a payment advice for every employee on
which the remuneration statement is printed. You can also print a payment summary that lists the individual
payments. You can use the payment summary to, among other things, post the wage and salary payments
manually to Financial Accounting if necessary.

Prerequisites

The payroll run is executed, and payroll results are generated for all employees. The preliminary program DME
has been run.

The user profile should have a valid printer assignment.

i Note

Select a printer other than LOCL, as the SmartForms or SAPScript forms require a unique, tested printer.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Log onas Access the Employee Central Payroll Menu and The Payment Medium:
Payroll Ad- 5 igate to | Human Resources ¥ Payroll % Americas Creation screen is displayed.
ministrator

% USA ¥ Payroll ¥ Bank transfer  Create DME-Payment

Medium Workbench ] or enter transaction code
PCOO_M99_FPAYM.
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Test
Step Test Step
# Name

Pass /
Instruction Expected Result Fail

2. Enter Data

On the Payment Medium: Creation screen, make the follow-
ing entries:

Run Date: use match code from drop-down list

Identification: is filled when the choice is made for the Run
Date field with the identification feature noted in the previ-
ous process step

Proposal run: leave unchecked

Payment Medium Format: select ACH(Domestic
payment transactions USA) and choose Enter.

i Note

Format of file sent to the bank. Per NACHA rules, this
must be a PPD format.

3. Choose For-
mat Param-
eters

In the Format section of the screen, choose Format The Other specifications for
Parameters. payment medium format

ACH dialog box is displayed.
i Note

This button shows up once you have entered value ACH
in the Payment Medium Format field.

4. Enter For-
mat Param-
eters

On the Other specifications for payment medium format
ACH dialog box, make following entries:

ACH Batch hdr. Company entry description: 01
Company identification: leave blank

Select Continue (Enter).

5. Enter Print
Control
Data

On the Payment Medium: Creation screen, in the Print
Control section of the screen make following entries:

Data Medium Exchange: flag checkbox to output the DME
message

Payment Summary: flag checkbox to output the payment
summary

Error Log: flag checkbox to output the error log
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
6. Enter Out-  Inthe Output Control section of the screen, make following
put Control entries:
Data . .
Payment Document Validation: flag checkbox to validate the
document
Output to file system: leave empty
File name: leave empty
Form Type: defaults to SAPscript; leave as is.
Form Accompanying Letter: leave empty
Payment Summary Layout: leave empty
Screen Output: flag checkbox
7. Select Out- In the Print Control section of the screen, choose Print The Payment Medium:
put Device  Parameters next to the Data Medium Exchange field. Creation dialog box for en-
tering printer details is dis-
played.
8. Enter Print  In the Payment Medium: Creation dialog box, make the fol-
Parameters lowing entries:
Output Device: <printer name>
Number of copies: <#>
Enter details as appropriate in the Spool Control and Cover
Page Settings sections of the dialog box.
When done, choose the OK pushbutton.
9. Repeat test Repeat test steps # 7 and # 8 for the selections Payment
steps #7 Summary and Error Log.
and # 8
i Note
If you default your print values in your user settings,
you do not have to do this test step.
10. Generate Choose Execute to generate the DME file. On the Payment Medium:
DME File Creation screen, a list of the
generated payment media is
displayed.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
11. Go Back Choose the Back pushbutton. The Payment Medium Tool
Output screen is displayed,
on which the system dis-
plays an overview of the
generated payment media:
details regarding the cre-
ated file itself, the error log,
and the payment summary.
12. View DME To display the detail of the documents, double-click the The Data Medium Overview
File Details output you wish to view. screen is displayed.
13. Start Down- On the Data Medium Overview screen, highlight the line The File Download dialog
load of DME item and choose Download from the menu bar, choose box is displayed.
File |» More... Edit  Download 3.
14. Enter DME  On the File Download dialog box, enter the file name and
File Name location of where the file should be saved:
File name: <DME Ffille name>
15. Confirm Choose Continue to confirm the download. The system displays the
Download Download successfully com-
of DME File pleted message.
The DME file is generated
and downloaded for send-
ing to the bank. The pay-
ment summary form and
payment advice are gener-
ated.
i Note

Sample variants for each payroll area have been delivered as part of the activation content.

Instead of executing test steps # 2 to # 6 you can choose on the Data Medium Exchange Preliminary
Program (USA) screen the Get Variant ... icon and select the appropriate variant name, as follows:

for payroll area UM (HR-US: Monthly) select variant YUS_HR_US_0OC_M

for payroll area US (HR-US: Semi-monthly) select variant YUS_HR_US 0OC_S
for payroll area UW (HR-US: Weekly) select variant YUS_HR_US _OC_W

for payroll area UX (HR-US: Bi-weekly) select variant YUS_HR_US_0C_X

Select the Run Date using match code from dropdown list; the Identification field is then filled
automatically.
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I Continue with test step # 7 from the table above.

4.24 Execute Fl Posting Run

Purpose

The Payroll Administrator executes the posting run to Financial Accounting.

The posting run to Financial Accounting (FI for short) creates a posting document that is transferred to Fl,
and the information is used to post an FI document. The information is reflective of the Expense and Liability
posting for Payroll.

Posting to Accounting includes the evaluation of the payroll results, the creation of summarized documents
and posting them in the Accounting components.

When posting to Accounting, the following activities should be performed:

* Creating a Posting Run

* Checking a Posting Run

* Checking the Posting Documents

* Releasing Posting Documents

* Posting Documents

* Checking Accounting Documents

* Checking the Completeness of the Postings

* Subsequent Activities in Financial Accounting

- Recommendation

A simulation of a posting run should be executed before and after completing payroll. In this way, you can
recognize posting-relevant errors in the payroll results early and avoid errors when creating a live posting
run. Both the simulation and live run are executed using the same transaction code.

Prerequisites

The payroll control record must be in status Exit Payroll.
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Procedure

Test
Step Test Step Additional Infor- Pass /
# Name Instruction mation Expected Result Fail
1 Logonas Access the Employee Central Pay- The Posting to Accounting:
Payroll roll Menu and navigate to |> Human Create Posting Run screen
Adminis- is displayed.
trator Resources > Payroll > Americas > USA pay

> Subsequent activities > Per payroll
period » Evaluation Posting to

accounting > Execute posting run ]
or enter transaction code
PCO0O_M99_CIPE.

2. Enter Pay-
roll Period
Data

Make following entries in the Payroll
Period section of the screen:

Period: Current Payroll Period
is defaulted; leave as is

Payroll Area: select UM(HR-
US:Monthly) and choose Enter.

3. Enter Se- Make following entries in the Selection
lection Criteria section of the screen:
Criteria

Personnel Number: leave empty

Payroll area: If not defaulted, use value
help to select UM(HR-US :Monthly)

A Caution

Select the same value as in the
Payroll Period section. Do not use
payroll area ranges.

Alternatively, in-
stead of executing
test steps # 2to #
6, you can proceed
as follows:

For each payroll
area, a sample var-
iant has been de-

livered within the
activation content
of this SAP best
practices to ease
executing this proc-
ess step. Select

on the Posting to
Accounting: Create
Posting Run screen
the Get Variant...
icon and choose the
appropriate variant
for the payroll area
for which you want
to execute the pro-
ductive posting run.
Then continue with
test step # 7 and
subsequent.
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Test

Step Test Step Additional Infor- Pass /
# Name Instruction mation Expected Result Fail
4. Enter Run Make following entries in the Run - Recom-
Attributes Attributes section of the screen: .
mendation
Off-Cycle Payroll Run: leave empty unless .
processing an off-cycle payroll Refer to config-
uration guide of
Type of document creation: select configuration
P(Live posting run) from value block Local
help Payroll Admin-
Output log: flag the checkbox in case istration fgr
you want to obtain a results log for all nelies d-etalls e
selected employees the delivered
variants.
i Note
In case you leave the checkbox un-
flagged, a log will only be output for
the rejected employees.
Text on posting run: enter text to identify
the posting document, if appropriate
5. Specify In the Specify posting date section of the
Posting screen, check the Acc. to Payment Date
Date radio button.
6. Enter Make following entries in the Data for
Document document creation section of the screen:
Creati
Dreta on Document Date: select from calendar
ata
help, or leave empty to default to today's
date
Posting variant: SAP
7. Execute FI Choose the Execute pushbutton. The Evaluation of Posting
Posting [tem screen is displayed.
Produc- The created posting run
tive Run has acquired the status
Documents created.
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Test

Step Test Step Additional Infor- Pass /
# Name Instruction mation Expected Result Fail
s Go to On the Evaluation of Posting Item screen, The Posting to Accounting:
. choose the Document Overview pushbut- .
Posting ton Document overview
Document ' screen is displayed, con-

taining the created docu-
ment, together with its
status. The status should
be Created.

i Note

As the Accounting
configuration is not in
scope of this SAP best
practices, no posting
documents will be
generated.

4.25 Process Fl Posting Run (Process Step Outside of Scope
Item Scope)

A\ Caution

A prerequisite for executing this process step successfully is the integration between the Employee Central
Payroll system and the SAP Finance system. As this integration is not in scope of the present SAP best
practices, this process step is out of scope, too, and therefore described in a general manner only.

Purpose

When checking a live posting run and the accompanying posting documents, the Payroll Administrator
establishes that all posting documents are technically correct and contain the right contents. To post the
posting documents, the Payroll Administrator must first release all posting documents for the posting run.

After all the posting documents have been released for a posting run, the posting run receives the status
All documents released. The Payroll Administrator can now post the posting documents. All the posting
documents belonging to a posting run must be posted together in the Accounting components. Individual
posting documents cannot be posted.
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To execute this process step, proceed as follows:

* Logon to Employee Central Payroll as a Payroll Administrator.

* Either navigate in the Employee Central Payroll Menu to |» Human Resources » Payroll » Americas » USA

» Subsequent activities ¥ Per payroll period * Evaluation » Posting to accounting * Process posting run 3
or enter directly transaction code PCPO.

¢ Onthe Display posting runs screen release all posting documents and then post the posting documents.

4.26 Execute Third-Party Remittance Run

Purpose

The Payroll Administrator executes this report to collect data from existing payroll results, that is relevant for
third-party remittance and posting to FI/CO, and update the third-party remittance tables for the organization.

Prerequisites

The payroll run must have generated payroll results and the payroll control record must be in status Exit Payroll.

Procedure
Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1. Log onas Access the Employee Central Payroll Menu and navigate The Create Third-
Payroll Ad- 4, |b Human Resources ¥ Payroll % Americas ¥ USA ¥ Subsequent ~ Farty Remittance
ministrator Evaluation Run

activities > Period-independent > Evaluation > Third-party remittance

} Evaluate remittance (New) } or enter transaction code
PCOO_M99_URME.

screen is dis-
played.

2. Enter Pay-
roll Period
Data

On the Create Third-Party Remittance Evaluation Run screen, make
following entries in the Payroll Period section:

Period: Current Payroll Period isdefaulted; leave as is

Payroll Area: select UM(HR-US :Monthly) and choose Enter.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
3. Enter Selec- On the Create Third-Party Remittance Evaluation Run screen, make
tion Criteria following entries in the Selection Criteria section:
Personnel Number: leave empty to run it for all employees in the
payroll area.
Payroll area: If not defaulted, use value help to select UM(HR-
US:Monthly)
A Caution
Select the same value as in the Payroll Period section. Do not use
payroll area ranges.
4. Enter Off- Off-cycle reason: leave empty unless processing an off-cycle payroll
Cycle Pay-
);I P Y Off-cycle Payroll Processing: leave empty unless processing an off-cy-
roll Proc-
. cle payroll
essing Data
(Optional)
5. Enter HR On the Create Third-Party Remittance Evaluation Run screen, make
Payee Type following entries in the HR payee type to be posted section:
HR payee type: leave empty to obtain all available HR payee items
6. Enter Con-  On the Create Third-Party Remittance Evaluation Run screen, make
trol Data following entries in the Control data section:

Inthe ALV control part, check the No ALV view radio button.

Unflag all checkboxes in the Level of detail on double-click part and in
the Detail for list outputpart, to reduce the run time in case of large
production runs.

i Note

You may leave them flagged for smaller runs of small groups of
employees.

Check the Production Mode radio button.
i Note

Any corresponding database table will be updated.

Display log: read-only in case No ALV view radio button has been
checked
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
7. Execute Choose the Execute pushbutton. A new screen
Third-Party is displayed, con-
Remittance taining the log
Evaluation of the remittance

evaluation run.

Result

The document for third-party remittance is now created. The system issues a log, listing HR payees for which
third-party remittance is payable, along with the amount and the due date. The earliest due date in the list
should be noted down; it is needed in the subsequent process step of running the third-party remittance
posting.

4.27 Execute Third-Party Remittance Posting Run

Purpose

This report extracts remittance items from the third-party remittance tables of the organization and places
them into a posting run. The posting run represents remittances in the form of a sequence of documents that
the Payroll Administrator can then examine, release, and post to Fl.

This report should be run at least once a day.

- Recommendation

Before executing the live third-party remittance posting run, it is recommended to execute a simulation of
the posting run. For this, when executing test step # 3 in Procedure table below, check the Test Mode radio
button. In this way, posting-relevant errors can be recognized and solved.

Prerequisites

The third-party remittance run has been executed successfully.
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Procedure

Test
Step Test Step Pass /
# Name Instruction Expected Result Fail
1 Logonas Access the Employee Central Payroll Menu and navi- The Create Third-Party
Payroll gate to [ Human Resources ¥ Payroll  Americas # USA Remittance Posting Run
Adminis- o o ) screen is displayed.
trator > Subsequent activities > Period-independent > Evaluation
} Third-party remittance > Create posting run } or enter trans-
action code PCOO_M99_URMP.
2. Enter On the Create Third-Party Remittance Posting Run screen,
Posting make following entries in the Posting data selection section:
Data Se-
a é € Company Code: select from value help
lection

Business Area: leave empty
HR payee type: leave empty

Due date: enter the earliest due date in the list HR payees
noted down in previous process step. Use the Less than/equal
to sign to ensure that earlier outstanding remittance items
are included in the posting run.

i Note

The due date determines when the payee must receive a
payment.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
3. Enter On the Create Third-Party Remittance Posting Run screen,

Control make following entries in the Control section:

Data

In the Transfer parameters part, make following entries:

Text on posting run: enter as appropriate, for example 3PR
Posting

Posting date: select from calendar help the date that the en-
tries are to be posted in Fl

A Caution

If you enter a date that is assigned to a posting period
that is either already closed or is not yet open, an error
will occur during the transfer to Fl.

Posting variant: SAP

Document Date: select from calendar help the date on which
the original document was issued

In the Processing option part, check the Production Mode ra-
dio button.

i Note

Any corresponding database table will be updated.

Unflag the Download/exp. TemSe checkbox.

Flag the Include due date chg checkbox.

i Note

If flagged, the remittance posting run log will also contain
information about items that have due date changes ac-
cording to their accumulator and limit.

Flag the Update already posted items checkbox.

- Recommendation

We recommend that you always leave this checkbox flag-
ged to ensure no existing items are overdue.
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Test

Step Test Step Pass /
# Name Instruction Expected Result Fail
4. Execute Choose the Execute pushbutton. A new screen is displayed,

Third- containing a log that lists

Party Re- all remittances due by Fl

mittance vendor and HR payee. The

Posting third-party remittance post-

Run ing run is displayed at the

bottom of the log.

4.28 Follow-Up Activities in Third-Party Remittance
Processing (Outside of Scope Item Scope)

Purpose

As mentioned at the beginning of chapter Test Procedures of this document, a successful execution of
Third-Party Remittance requires the existence of payee data in the Employee Central Payroll system as well as
the integration to the SAP FI/CO system of your company. Both these prerequisites are not part of the present
SAP Best Practices package. Therefore, the majority of the process steps sketched at the beginning of chapter
Test Procedures are not in scope of this package.

For details to the subsequent steps to be executed within the Third-Party Remittance process (like processing
of third-party remittance run, reconciliation of third-party remittance postings, or creation of third-party
remittance payment), refer to the documentation of the SAP Payroll Process for the United States existing

on the SAP Help Portal.

Once you have executed the third-party remittance steps, you can check with help of the Remittance
Completeness Check Report (transaction PCOO_M99_URMC), whether there are any open third-party
remittance items. Based on the three different types of completeness checks that can be executed, you obtain
following results:

* Employees and payroll results that have not been evaluated.
* All payee items that have been evaluated but not posted to Financial Accounting (FI).
* All posting runs in transaction PCPO (Display posting runs) that have not been released.

Ideally, the result list of each of these completeness checks is empty. If this is not the case, you need to execute
again dedicated process steps within the third-party remittance process to clear each list.
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Result

All third parties to which tax, garnishment, membership or benefits payments are owed have been paid. The
amounts have been posted to the appropriate general ledger, subledger and bank accounts in FI/CO.
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5 More Information

5.1 Executing Payroll and Post Payroll Processing Using
Payroll Control Center Integrated in Employee Central

In case the Payroll Control Center is integrated in Employee Central, instead of accessing the Employee
Central Payroll Menu, the end-users can execute the payroll and post payroll processing directly in the
Employee Central system. This system calls the Employee Central Payroll system, via the Payroll Control
Center screen, which is exposed through a gateway.

When using the Payroll Control Center, three pre-configured processes are delivered, each of which contains a
certain number of sequential process steps to be executed:

* Team Monitoring: The process designed for creating test payroll results and running policies (these being
groups of validation rules), which are based on real payroll results. The alerts issued during this phase
can be assigned to specified administrators for resolution, or the administrators can assign them to
themselves from the list of alerts. By taking care of all alerts appearing during this phase, the perfect
payroll data will be achieved for the productive payroll run. Basically, process steps Execute Payroll
Simulation Run [page 17] to Release Payroll Area [page 26] within this document would be covered by
this preconfigured process.

* Production Payroll: The process designed for running the productive payroll, as well as the posting
simulation run. In case alerts are issued during this phase, they can be assigned to specified
administrators for resolution, or the administrators can assign them to themselves from the list of
alerts. The alerts need to be solved before conclude the payroll processing. Basically, process steps
Execute Payroll Run [page 27] to Exit Payroll [page 49] within this document would be covered by this
preconfigured process.

* Posting to Finance: The process designed for executing the post payroll processing activities. Basically,
process steps Create Payment Data Using Preliminary Program Data Medium Exchange [page 54] to
Process FI Posting Run (Process Step Outside of Scope Item Scope) [page 68] within this document would
be covered by this preconfigured process.

To execute the Team Monitoring pre-configured process, proceed as follows:

* Logon to Employee Central as a Payroll Administrator.

¢ Select from the Home dropdown Payroll. You will be requested to enter your login data to the Employee
Central Payroll system.

* Select on the My Processes screen the UPCOMING PROCESSES (#) tab.

* Search for the Team Monitoring process of the relevant payroll area and period that needs to be started and
choose Start Process next to that process.

* Execute each step as described in test script of scope item
Manage Payroll Processes and Analyze Payroll Anomalies Using the PCC from the SAP Best Practices for
SAP Payroll Processing control center.

To solve the errors revealed by the check policies, proceed as follows:

* Logon to Employee Central as a Payroll Administrator.
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¢ Select from the Home dropdown Payroll. You will be requested to enter your login data to the Employee
Central Payroll system.

¢ To check which alerts have been assigned to you for solving, select on the My Processes screen the My
Alerts tab.

* To assign alerts to yourself from the team alerts page, select on the My Processes screen the Unassigned
Alerts tab.

* Execute each step as described in test script of scope item Manage Payroll Processes and Analyze Payroll
Anomalies Using the PCC from the SAP Best Practices for SAP Payroll Processing control center.

To execute the Production Payroll pre-configured process, proceed as follows:

* Logonto Employee Central as a Payroll Administrator.

* Select from the Home dropdown Payroll. You will be requested to enter your login data to the Employee
Central Payroll system.

* Select on the My Processes screen the UPCOMING PROCESSES (#) tab.

* Search for the Production Payroll process of the relevant payroll area and period that needs to be started
and choose Start Process next to that process.

* Execute each step as described in test script of scope item Manage Payroll Processes and Analyze Payroll
Anomalies Using the PCC from the SAP Best Practices for SAP Payroll Processing control center.

To solve the errors revealed by the check policies, proceed as follows:

* Logon to Employee Central as a Payroll Administrator.

¢ Select from the Home dropdown Payroll. You will be requested to enter your login data to the Employee
Central Payroll system.

* To check which alerts have been assigned to you for solving, select on the My Processes screen the My
Alerts tab.

* Execute each step as described in test script of scope item
Manage Payroll Processes and Analyze Payroll Anomalies Using the PCC from the SAP Best Practices for

SAP Payroll Processing control center.
To execute the Posting to Finance pre-configured process, proceed as follows:

* Logonto Employee Central as a Payroll Administrator.

* Select from the Home dropdown Payroll. You will be requested to enter your login data to the Employee
Central Payroll system.

* Select on the My Processes screen the UPCOMING PROCESSES (#) tab.

* Search for the Posting to Finance process of the relevant payroll area and period that needs to be started
and choose Start Process next to that process.

* Execute each step as described in test script of scope item Manage Payroll Processes and Analyze Payroll
Anomalies Using the PCC from the SAP Best Practices for SAP Payroll Processing control center.

5.2 Process Integration

The process to be tested in this test script is part of a chain of integrated processes.
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5.2.1 Preceding Processes

You may first have completed the following processes and conditions before you start with the test steps:

Process Business Condition

Update Payroll-Relevant Data The employee's master data record has been replicated successfully to SAP Success-
Factors Employee Central Payroll. Payroll-relevant data has been maintained for the
employee.

Replicate Absence Data If appropriate, short-term absence data for a particular payroll period have been main-
tained and replicated successfully to SAP SuccessFactors Employee Central Payroll.

Manage Third-Party Benefits The employee has been enrolled in benefits he or she is eligible for, more precisely in
(Optional) savings plans.

5.2.2 Succeeding Processes

After completing the activities in this test script, you can continue testing the following business processes:

Process Business Condition

Retroactive Payroll Proc-  Employee payments for previous payroll periods can be adjusted if needed. Retroactivity refers

essing (Optional) to the ability to make employee master data changes before the current pay period. SAP
SuccessFactors Employee Central Payroll then automatically recalculates previous periods and
adjusts the results accordingly.

Period End Closing for Activities required for daily/month-end, quarterly-end and year-end closing in payroll are pre-
HCM pared and carried out using a set of standard reports for generating evaluations and analyses
of payroll.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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© 2023 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
SAP affiliate company products and services are those that are set forth
in the express warranty statements accompanying such products and
services, if any. Nothing herein should be construed as constituting an
additional warranty.

SAP and other SAP products and services mentioned herein as well as
their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
respective companies.

Please see https://www.sap.com/about/legal/trademark.html for
additional trademark information and notices.

THE BEST RUN
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